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_==" Objectifs

Prise en main de I'environnement ANSYS Electronics Desktop (V16) — HFSS
Import d’un fichier géométrique (.step) et enrichissement du modele
Simulation de paramétres S 4 ports d'une common-mode choke

Export des paramétres S pour une étude sous de ANSYS Electronics Desktop
(Nexxim Circuit Simulator)

> Créer un composant 3D intégrable dans de futurs modeles

vV V V V
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Modele d'origine

> Common-mode choke TDK ACT45B
> Fichier step disponible
> Ne donne que le modele du corps du boitier et les pads
> La nature des matériaux n'est pas précisee.
=="==1 J
-l D70 | o | oes:0 ' T

Dimensions in mm Dimensions in mm
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/
=" Création du projet / design HFSS
File > New > création d’'un nouveau BOD RS
pro J et Project Manager
Renommer en ProjetCMC (] Definitic (2 Paste CtrlsV
x zrt:t:mject Permanently from Disk Delez

Insertion d’'un design HFSS, quon : B fert ;
nommera CMC_ACT45B. 2

HBOR Wy

Project Manager

File > Save as - sauvegarde du projet S S

Paste

r,_"l Definitions |

Renarne F2
Réglage du type de Solut|0n (Tools > x |DE|:rttEPI'DjECtPermanentlyfrom Disk Delete l —
i H i > nsert esign
Optlons > General Optlons ) Clis Insert HFSS 30 Layout Design
EH save CrlsS Insert HFSS-IE Design
Save As... Insert Q30 Extractor Design

Insert 20 Extractor Design

Réglage des unités (en mm) : Modeler > e—

. Name | Value Project Variables...
U n Its Project Datasets... Insert Filter Design ...

Insert Circuit Design
Insert Circuit Metlist

FHADASZSE &
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—" Import du fichier STEP

> Modeler > Import
> Sélectionner act45b.step. Non centré sur l'origine du repére - on va le déplacer.

EIW
-4 Mot Assigned

V'
&P ACT45B_q_u__b_Ntypsize
&P ACT45B_q_u__b_Ntypsize_1

F-&7 ACT45B_q u__b_Ntypsize_2

F-7 ACT45B_q u__b_Ntypsize_3

: Coordinate Systems
3.@ Pla
- Lists

[ | L
0 5 10 (mmy)

> Modeler > Movement mode : sléectionner le type de déplacement adéquat.

> Edit > Arrange > Move : on décale le modele géomeétrique le long de I'axe Z pour qu’il soit
« posé » sur le plan Z = 0. Le centrer dans le plan XY.
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g —" Import du fichier STEP

¢ Validation Check: ProjectCMC - CM5_ACT45B b

> Vérification du modéle : Validate

: ) ras | w¥ Design Settings
” ReSUItat ) ',QJ ChS_ACT458 0 Madel

= Erreurs « Boundaries and Excitation », Eoundaries and Excitations
« Analysis Setup » a ignorer car pas encore Validation Check completed. Erors: 12 Warnings: 0 & Mesh Operations

P Analyziz Setup
définies. " Optimetrics

= Probleme sur le modéle 3D ! & Fadiation

See Mezsage Window for details.

Cloze

lessage Manager I =

i ’JQ Mo material is assigned for "ACT458__q_u___ b Mtypsize 1. (10:23:17 mai 22, 2020 -
i ’JQ Mo material is assigned for "ACT458__q_u___ b Mtypsize 2" (10:23:17 mai 22, 2020
,Jm Mo material is assigned for "ACT458__q_u___ b Mtypsize 3" (10:23:17 mai 22, 2020
m At lzast one material assignment should have solve inside set! (10:23:17 mai 22, 2020)
i m Boundary Setup: An excitation must be defined in arder to solve driven problems. (10:23:17 mai 22, 2020)
— —@-Sdﬂinnﬁeﬂp: [dgagoletinreaetips hawe haen Seated . (o dul 7 o] duy 70 e o o - - - o = - . . .
- »Mgd Objects "ACT45BDR_R_A_u__b_Ntypsize"” and "ACT45B__q_u__b_Ntypsize” intersect. (10:23:22 mai 22, 2020) Pr'Obleme ‘ Intersection entre |eS
J‘)Q Objects "ACT45BDR_R_A u___ b MNtypsize" and "ACT458__q_u__ b Mtypsize 1" intersect. (10:23:22 mai 22,

2020 .
‘)J'EB Objects "ACT45BDR_R_A u__ b Ntypsize" and "ACT458__q_u__ b Mtypsize 2" intersect. (10:23:22 mai 22, ObJ ets pads Et |e Corps du

2020) H H
fB Objects "ACT45B0R_R_A_ u__ b Ntypsize” and "ACT45B__q_u__ b MNiypsize_3" intersect. (10:23:22 mai 22, Composant 9 IntrOdUIra un

2020) N .
IEBI-ND matenial is asmgned for "-“-.CT#EBDH_H_A_U_b_M:.'pmze {'H]I 2322 ai 22, EEED} mEm_m—m— p ro b | eme d e mal | |age
";Jﬂ} Mo maternal is assigned for "ACT45B__q_u__ b Mypsize”. (10:23:22 mai 22, 2020)
";Jﬂ} Mo matenal is assigned for "ACT45B__ g u__ b Miypsize 1" (10:23:22 mai 22, 2020}
";Jﬂ} Mo matenal is assigned for "ACT45B__ g u__ b Miypsize 2" (10:23:22 mai 22, 2020}
‘,_J.[B Mo matenal is assigned for "ACT45B__ g u__ b Mypsize 3" (10:23:22 mai 22, 2020}
i IEBI At least one materal assignment should have solve inside set! {(10:23:22 mai 22, 2020)
IEBI Boundary Setup: An excitation must be defined in order to solve driven problems. (10:23:22 mai 22, 2020)

IEB Solution Setup: Mo solution setups have been created. (10:23:22 mai 22, 2020) =
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2= |mport du fichier STEP

. . T . @ Subtract >
> Solution : on va soustraire a I'objet corps du composant
. . Blank Partsz - Tool Parts
(ACT45BDR—R—A—u—b—NtypSIZe) |eS 4 Objets pads ACTA5BDR_R_A_u_ b Mippzize ACT45B_qu b Miypsize
, . . = ACT45E g u_ b Mivpsize 1
> On sélectionne tous les objets. ACTA5E @ b Niypsizs 2

ACTA5E g u_ b Miypsize 3

> Modeler > Boolean > Substract

[T Clone tool objects before operation

lls ont été « absorbé » par la o o
création du nouvel objet = -

B Solids
-4 Mot Assigned
B-47 ACT45BDR_R_A_u__b_Ntypsize;

B Import
[|b|:| Mowve
[l*[l Move
[|b|:| Move
[|p|:| Mowve
I3 Subtract

|_;._f' ACT45B__q_u__b_Ntypsize 2

._.7' ACT43B_g u__b_Ntypsize_1

|_? ACT45B__q_u__b_Ntypsize
-7 ACT45B_q_u__b_Ntypsiz
EEI---L{. Coordinate Systems
-4 Planes

&5 Lists

Les 4 pads ont disparu

4 (mm) 7
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== |mport du fichier STEP

> On copie-colle les 4 objets pads pour les faire apparaitre comme de nouveaux objets indépendants.
> Veérification du modéle : Validate

Bl Solids

Eg Mot Assigned
B &7 ACTASE_q u__b_Ntypsize 4
[P ACT4SB_q u__ b Mtypsize 5
- ACT43B_q u__h Mtypsize 6
l & ACTA3B_q u__b Ntypmze'l

[0 Move

E1-[d Subtract
[P ACTASB_q u__b_MNtypsize 2
@-P ACTASB_q u__b_MNtypsize 1
[P ACTASB_q_u__b_Ntypsize

P ACTASE q . b Miypeize. 3.
@12, Coordinate Systems

[+-4F Planes
-2 Lists
Validation Check: ProjectCMC - CMS_ACT43B bt
0 — = .
I[QJ CMS_ACT45E Sgsﬁzd?umgs
. ;- . - b¥ Boundaries and Excitations
Les 4 problemes d’itnersection ont alidatin Check compietad o Mesh Operations
. N , : _ i Analyziz Setup
disparu. Les autres problemes (déf. Des o Oplimetics
matériaux, Boundaries et analyse) seront e Hossage Window fordatail s
réglés dans les prochaines étapes.
Abart Cloze
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_==" Attribution des propriétés des matériaux

=g Solids
. . Es Mot Assigned
> Edit > Select > Object 7] ACTASE_q u__b_Ntyps
. . . ) ACTASB_q u__ b Niyps
> On sélectionne les objets correspondant o ﬁ;_,ﬁ_a;‘f_:;bjw;g?
aux 4 pads L A CT458_q u__b Niyps
-7 ACTASBDR.R A u_ b N
> Dans le volet Properties : e-l¢, Coordinate Systems
- Planes
F-48A Lists
Properties o x
Mame J‘u’aluel Linit | Eval »
Mame
Material " o
Solve Inside | |
S ﬁ On attribue du cuivre comme matériau et on
Model v
- change la couleur
£ >
Attribute |

> On peut aussi changer le nom des 4 objets pads, pour mieux les identifier dans la suite

Laboratoire d’analyse et d’architecture des systémes du CNRS




LAAS |
CNRS

—" Aftribution des proprietés des materiaux

> Edit > Select > Object

> On sélectionne I'objet correspondant au corps & Pocs

de la choke

> Dans le volet Properties : on attribue le
matériau ferrite et on change la couleur.

i@ View / Edit Material

b aterial Mame
|ferrite

 Properties of the Material

Mame Type Walue Units

Relative Permittivity Simple
Rielative Permeabiliy Simple 1000
BT Canductivity Simple om sigmensdm
[ Diglectrc Loss Tangent | Simple 0
] tagrnetic Lozs Tangent | Simple 1]
[ t agnetic S aturation Simple i] tesla
N Lande G Factar Simple 2
[ Delta H Simple 0 A per_meter
[ - Meazured Freguency  Simple 94e+008 Hz
[ Mass Dengity Simple 4600 ka/m”3
Set Frequency Dependency... J |Calculate Froperties for: __J

[[ ok | cancel |

 Wiew/E dit Material for

@ pActive Design
" This Praduct

Al Products

 Wiew/E dit Modifier for

[ Thermal Modifier

alidate b aterial

E-@7 Solids

-4 ferrite
-7 CorpsFerrite
-7 Padl
- Pad2

P Padd

@12, Coordinate Systems
-2 Planes

-4 Lists

Le modele fréquentiel exact n’étant pas
connu, on l'ignore.
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Creéation du bobinage interne

> Le modéle de bobinage interne n'est pas donné par le constructeur. |l ne peut étre extrait que par
reverse engineering puis construit a I'aide des outils de construction géomeétrique de HFSS.

> Processus long !

> On va proposer un modéle simple : 2 boucles de 1 mm de large, séparées de 0.5 mm, formées par
des fils de 0.05 mm de rayon.

> On créera autant que possible et au fur et a mesure de la construction du modéle des variables
pour le rendre paramétrique.

> Ca devrait vaguement ressembler a ¢a :

Laboratoire d’analyse et d’architecture des systemes du CN
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—" Creéation du bobinage interne

> On créeé la boucle Loop1, connecté entre pad2 et pad3 (la plus basse).
> On créé un arc de cercle Draw Center Point Arc )

Position 1{Reference) = [0.4, 0.9, 0Jmm
Position2{Current) = [0.3, 0.9, 0]mm
Distance = 0.7mm

¥ Distance = 0.7mm

¥ Distance = Omm

Z Distance = Omm

Angle(P20 -P10) = 42.3974378deg

Close
-

Hold txt, '¥1, or 'Z20 Key to conztrain relative movement.

Objet Loop1l (pour I’instant, aucun
matériau attribué, et aucun rayon défini)

Laboratoire d’analyse et d’architecture des systeémes du CNRS

Properties: ProjectCMC - CMS_ACT45B - Modeler

Segment

Mumber of Seq...|0

0

MName Value | Unit | Evaluated Value Description
Segment Type |Center Poirt Arc
W Start Point Rloop sgrt(2)/2 Rloop sqt{2)/2 Hloop 0.70710678118655mm , 0.70710...
—Cerﬂer Point Omm .0mm . Hloop Omm , Omm . 0.5mm
W Angle -270 deg -270deg
w Plans XY
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Creéation du bobinage interne

> On créeé les fils de connexion entre Loop1 et Pad2
> Draw Line

Objet Loopl Pad2 Fill

Hold 'x!, ', or 12! key to constrain relative movement. K’;

Ctr1-Click to change reference position, I
TN
Uze context menu to chooze In Plane movement. 05 1(mm)

Mame Value Linit Evaluated Value

Segment Type | Line
Paint1 1.5264692756608 1. 2282852729146 0.05 i 1.5264692756608mm |, 1.228285...
Pairt2 Rloop sgrt(2)/2 ,1.2282852725146mm ,0.05mm 0.70710678118655mm , 1.22828...

Laboratoire d’analyse et d’architecture des systémes du CNRS
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—" Creation du bobinage interne

> Onrelie Loop1 et Loop1 Pad2_Fil1
> Draw Line

Uze context menu to choose In Plane movems ; 3 (mm)

Laboratoire d’analyse et d’architecture des systémes du CNRS
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—" Creéation du bobinage interne

> On fait la méme chose entre Loop1 et Pad3. Le plus simple est de créer un copie des 2 fils de
connexion avec une symetrie par rapport au plan YZ. B|h

> Sélection des 2 fils de connexion. Edit > Duplicate > Mirror Duplicate

> Sélectionner Along X axis comme mode de mouvement. Deux points sont a sélectionner pour
définir le plan de symétrie : le point d’'ancrage et la direction de la normale du plan.

> S’assurer que le fil touche mais ne pénétre pas dans Pad3. Vérifier la validité du modéle Validate.

Hold &', 1YY, ar 121 key to constrain relative movement

Ctr1-Click to change reference position.

Uze context menu to chooze In Plane movemerngd.

Laboratoire d’analyse et d’architecture des systeémes du CNRS
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Creéation du bobinage interne

> On créeé la boucle Loop2, connecté entre pad1 et pad4 (la plus haute).

> On sélectionne Loop1. Edit > Duplicate > Along Line EHZI (se mettre en mode de mouvement
Along Z)

> Les séparer d’une distance SepLoop = 0.5 mm.
> Edit > Arrange > Rotate : rotation autour de I'axe Z d’'un angle de 180°

Laboratoire d’analyse et d’architecture des systeémes du CNRS
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Creéation du bobinage interne

> On créé les 2 fils de connexion vers les pads 1 et 4. On réutilise les mémes méthodes que
préceédemment.

> Le résultat final doit ressembler a cela :

B-&” Solids

-4 copper

-4 ferrite

E-™ Lines

"\+ Loopl

"M Loopl1_PadZ_Fill

- Loopl_Pad2_Fil2

"\+ Loopl_Pad3_Fil

*\+ Loopl_Pad3_Fil2

*\H Loop2

"\+ Loopd Pad1_Fill

*\+ Loop2_Pad2_Fil2

E|H‘“ Loop2_Pad4d_Fill

i [E-™ CreatePolyline

...w Createline H‘_
*\+ Loop2_Padd Fil2
=1, Coordinate Systems
.8, Global

..@ Planes

w9 Lists

0 25 5 (mm)
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>  Problemes :

= Ces fils ne sont pas encore des objets physiques. Il faut leur donner une section pour pouvoir les mailler en

volume.

= Sile modeleur 3D les interpréte comme des fils indépendants (non reliés), il risque de créer une intersection
d’objets, générant une erreur de maillage.

> On commence par unir les différents fils :
= Sélectionner les objets Loop1 et les 4 fils de connexion vers Pad2 et Pad3.

Creéation du bobinage interne

= Modeler > Boolean > Unit

= Le nouvel objet est renommé automatiquement Loop1. On peut le renommer Bobinage1.

= Méme chose avec les objets Loop2 et les 4 fils de connexion vers Pad1 et Pad4.
k7 Solids

Laboratoire d’analyse et d’architecture des sysl

g copper
- ferrite

=" Lines

E‘N Bohinagel

@™ CreatePolyline
D B! DuplicateAlongLine
=04 Unite

= ~ e

- DuplicateBodyAlong
.00 Rotate

#-0h Unite

B, Coordinate Systems

. Global

&% Planes

B

f-45 Lists

B {mm}
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> On donne aux objets Bobinage1 et Bobinage2 des
sections circulaire de rayon Rwire = 0.05 mm.

> Dans la liste des objets, sélectionnez tous les objets
CreatePolyline.
> Dans le volet Properties :

= Type : sélectionner Circle pour définir une section
circulaire

= Width/Diameter : 2*Rloop

Laboratoire d’analyse et d’architecture des systémes du CNRS

Creéation du bobinage interne

#-F ProjectCrMc®

Narme | Value | Linit
Command CreateP ...
Coordinate System Global |
Nurmber of points -
W
—Cross Section - .

< Type Circle
Width/Diameter | 2*Rwire |
W
Bend Type -Cumer .
< >
Command ]

Bl

¢ Loopl_Pad2 Fill A
"o~
. ! DuplicateMirror
54 Loopl_Pad2_Fil2
-~ T
! DuplicateMirror
Bobinageld
& DuplicateBodyAlongline

. @-” Bobinagel

&

*\+ CreatePolyline

i DuplicatelongLine

1]5 Rotate

OL Unite
-7 Loop2_Pad2_Fil2
o~
-J] DuplicateMirrar
- Loopd_Padd Fil2
=] DuplicateBodyMirror
57 Loop2_Pad2_Fil2
o ~ T
EJ CuplicateMirr:
-3 Loop2_Padd Fill

*\H CreatePolyline

=4 Loop2_Padl_Fill v

Il n’y a plus qu’a attribuer le matériau
aux 2 objets bobinage = Cooper.
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Création des ports et excitation

> On va placer 4 ports au niveau des 4 pads, qui seront directement connectés a un plan de masse
parfait, situé a 0.1 mm sous la common-mode choke.

> Draw Plane : largeur = 2*Wgnd avec Wgnd = 20 mm et situé a Hgnd = 0.1 mm sous la CMC.

> On nomme cet objet GndPlane.
> HFSS > Boundaries > Assign > Perfect E

Laboratoire d’analyse et d’architecture des systémes du CNRS
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—" Creation des ports et excitation

> On commence par créer le port 1, associé a Pad1.
> Le plus simple : sélection d'un edge, Modeler > Edge > Create object from edge puis Draw >
Sweep > Along vector, mais bug avec la version Ansys 16.2

> Alternative : on crée 4 rectangles entre chaque pad et le plan de masse.

E||:| Unassigned
-3 RectanglePort]
: ----- —1 CreateRectangle
. L.[O Coverlines
--I:I RectanglePort2
E|I:I RectanglePort3
- RectanglePortd

F-"™ Lines

=-le, Coordinate Systems

.9, Global

EI@ Planes

m-€9 Lists

G (mm)
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LAAS |
CNRS

—" Création des ports et excitation

> On sélectionne ces 4 rectangles
> HFSS > Excitation > Assign > Lumped Port
> Chosir GndPlane comme référence.

Project Manager Sl 57 Solids
&P Maodel o || -3 Sheets
[-EF Boundaries El Lumped Port
=B Excitations E||:| Perfect E
--@ Ell:l GndPlane
- 2 i1 CreateRectangle |~
- 3 t..d CoverLines
El@ 4 -« Lines
B8 Mesh Operations I';‘ITA Coordinate Systems
B Aralcie YN -, Global
. 2 | EI@ Planes
Properties o % @ Licte

Name ]‘u’alue | Lnit | Evaluate
Name 1
Type Lum... -
Resistance |50 ohm | 50chm
Reactance 0 lohm | Dohm

Mum Temi... 1

Deembed [
Renom Al.. v
€ >
|~ — = == ]
HF55 < » & (mm)
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_==" Création airbox

> On crée 'objet airbox, dont les bords sont délimités par le plan de masse.
> On fixe comme hauteur de cet objet Hairbox = 2*\Wgnd.

> On sélectionne les faces de 'objet airbox (sauf celui en contact avec le plan de masse) et on leur
attribue la condition aux limites Radiation.

Properties: ProjectCMC - CMS_ACT45B - Modeler X

Command | Aitribute |

MName I Walue I LUnit I Evaluated Value Description I |
Command CreateBox
[ Coordinate Sys... Global
[ Position -Wand -Wand .-Hgnd -20mm , -20mm , -0.1mm
[ XSize Z2"Wgnd 40mm
[ [Size Z'Wand 40mm
R T

Laboratoire d’analyse et d’architecture des systemes du CNRS
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>

>

Fréquence d’analyse : 2 GHz

Driven Sclution Setup

General letinns ] Advanced ] Expression Cache | Dervatives ] Defaults ]

Setup Mame: |Setl.||:|1

[v Enabled [ Solve Ports Orly

Solution Frequency: |2 |GH2 j

Adaptive Solutions

Maximum Mumber of Passes: |'I 0

{* Maximum Delta 5 |[:'-|:'2

" Use Matrix Convergence

Configuration de 'analyse

HFSS > Analysis Setup > Add Solution Setup

Driven Solution Setup

llse Defaults

Laboratoire d’analyse et d’architecture des systémes du CNRS

General Options lAdvanced Expression Cache Deﬁvatives] Defaurts]

Intial Mezh Options

I¥ Do Lambda Refinement
Lambda Target: |(0.3333 ¥ Use Default Value

[ Use Free Space Lambda

Adaptive Options

Maximum Refinement Per Pass: I %

rrrrrr

[~ Maximum Refinement: 1000000

Minimum Mumber of Passes: 1
|17

Minimum Converged Passes:

Solution Options

Order of Basis Functions: |F|r5t Order ﬂ

{* Direct Solver

(" lherative Solver

" Domain Decomposition

vvvvv

Use Defaults
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—" Configuration de I'analyse

> HFSS > Analysis Setup > Add Frequency Sweep

Edit Frequency Sweep >

General l Interpolation | Defautts |

Sweep Mame: |Sweep v Enabled

Sweep Type: |Inter|:u:|lating ﬂ

Freguency Sweeps [71 points defined]

Distribution Start End
1 |Log Scale 0.01GHz 2GHz Sam

30

51}
J
(1]
"]

Preview ... |

Time Domain Calculation... |

Laboratoire d’analyse et d’architecture des systémes du CNRS
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_—/

> Vérification du modéle : Validate J,,

>  Lancement de la simulation : Analyze

g

Design Y arigtion: |ﬂ'HIoop:'D.Smm'HIoop1='D.5mrn'Flloop='1mm'Flwire:'D.DSmm'SepLoop:'D.Smm'Wgnd='2Dmm' J |v

Profile ~Convergence l Matrix Data | Mesh Statistics

Mumber of Passes
Completed 3
Maximurm 10
Fimimum 1

Max Mag. Delta S
Target 0.02
Current 0017372

Wi O Table * Plot

we |Pass Murber

[l
i |MaH tMag. Dalta 5 j
COMVERGED

Congecutive Passes
Target 1
Curent 1

Default Settings

Save Defaults Clear Defaults

Max Mag. Delta 5

0.10

Tatal numl:n_er u:lf. eléments: 35807

Verification du modele et analyse

Stoppé au bout de 1h17...

Profile lConvergence ] Matrix Data ] Mesh Statistics ]

Design Variation: |ﬂ' Hloop="0.5mm' Hloop1="0.5mm’ Rloop="Trmm' Rwire="0.05mm" Seploop="0.5mm’ ‘»gnd="20mm’ J ‘ w

Task | Feal Time | CPU Time | temary

Information #

Frequency: 1.840429,

Simulation Setup 00:00:02 00:00:02
b atrix Azzembly 00:00:02 00:00:02
Salver DCST 000032 000032
Field Recoverny 00:00:00 00:00:00
Frequency: 0.515625. ..

Simulation Setup 00:00:02 00:00:02
b atrix Azzembly 00:00:03 00:00:02
Solution Process

Total 723 0:1E:41

Full Selution #1117
707 M Disk = D EBytes
150 M Digk = D EBytes, 24507 tetrahedra . 1: 19 triangles , 2: 17

125G Disk = D EBytes, matnx size 172738 | matrix bandwidth 2
125G Dizk = O KBytes. 4 excitations
Interpolation Eror: 5 Matrix eror 1.51462 %
Full Selution #1118
707 M Disk = D EBytes
150 M Digk = D EBytes, 24507 tetrahedra . 1: 19 triangles , 2: 17

Elapsed time : 01:22:01 , Hfss ComEngine Memory : 47.8
Time: 05/22/202015:38:57, Status: Aborted

Mum Tets Min edge le... | Max edge le... | BMS edge le... | Min tet vl |k ax tet ol | Mean tet v .| 5td De
Airtbox 4118 00160655, 28.2129 4. 79345 341916e-.. 1288.31... 1855321 85307
Bobinagel_1  |5214 00186857 0.409681.. 0712555 11143 e-.. 0.0002027.. 1.11886=-.. 1.4808
Eobinagez h399 0.0211 0409681, 0126141 1.87863e-.. 0.0001867.. 1.1929-0.. 1.4722
CorpsFernite 20389 0.020048.. 075 0342395 1.2393e-0.. 0.0227514... 0.0018537... 0.0024
Padi 171 oi1a1107.  1.06171 0459155 43607 e-.. 0.0104416... 0.0012087... 0.0072
Padz 168 00804163, 0.838627..  0.485071 8.74647e-.. 0.0080519.. 0.0012303.. 0.0013
Pad3 175 00963093, 1.27285 0449368 2.08518e-., 0.0137333.. 0.0011817... 0.0015
Pad4 173 0179518, 0836426 0434815 7.08022e-.. 0.0060BE7.. 0.0011948.. 0.0012
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Reésultat de simulation parametres S

> Simulation parameétres S11, S12, S13 et S14

AY Flot 1 CMs_ACI408 &
0.00 Curve Info
] — dB(SH{Pad1_T1,Pad1_T1})
7 Setup1 : Sweep
] — dB(StPad1_T1,Pad2_T1))
g Setup1 : Sweep
-12.50 — dB(St(Pad1_T1,Pad3_T1))
1 Setup1 : Sweep
] — dB(St{Pad1_T1,Pad4 T1})
7 Setup1 : Sweep
-25.00 —
> ]
-37.50
-50.00 —
6250 T T T T I T | T
0.01 0.10 ‘1.!30 10.00

Freg [GHZ]
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Reésultat de simulation parametres S

> Simulation parameétres S11, S14, S22 et S23

XY Plot 2 CMS_ACT458 4
0.00 . ——T V \/W Curve Info
J —— dB(St{Pad1_T1,Padi_T1))
| Setup1 : Sweep
- —— dB(St{Pad1_T1Pad4 T1))
-10.00 — Setup1 : Sweep
T _ —— dB(St{Pad?_T1,Pad2 T1})
: ; ' Setup1 : Sweep
J ; R —— dB(St{Pad?_T1,Pad3 _T1))
-20.00 — 'If' \" Setup1 : Sweep
;—BU.UU ] ‘
-40.00 —
-50.00 —
_EUUU i T T T T T T T T

=]
=]
e
=
_——
=]
=k
=]
—
=]
L=
=

Freg [GHZF
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Extraction parametres electriques

> On exporte les parameétres S dans un fichier .s4p (Network Data

Explorer)
sz . . . . Fadl T1 Fadd T1
> On créé un circuit contenant le modéle de la CMC via un Nport F-:.E?' p:—d%rﬂ
sous Nexxim Circuit Simulator. Port] = = P
> Extraction des inductances de chaque bobinage : =
XY Plot 1 Circuit1 4
100.00 — Curve Info
| [T~ St
m1 0.0100 | 0.2956
T L1=2.817 pH
L2 =4.704 pH
E 10.00
5 E
g
i)
& 1.00
= ]
§
U1U T T T T T T T T | T T T T T T T T T T T T T T T
0.01 0.10 1.!]0 10.00

F [GHZ]
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maag(Z(Port1 Port2)) [kOhm]

CNRS

> On exporte les parameétres S dans un fichier .s4p (Network Data

Extraction parametres électriques

Explorer)
7z : . . . ot Pad1_T1 Pad4 T1
> On créé un circuit contenant le modele de la CMC via un Nport |
: . Pot?  Pad2 T1 Pad3_T1 0
sous Nexxim Circuit Simulator. =
> Extraction de la mutuelle inductance : Ee=
AT FIOT | 2
100.00 —+—t— |
] [hame [ x [ v e
4 m1 0.0100 | 0.0285
10.00 =
1.00 4
0.10 =
]
%)
0.01 T T T T
0.01 10.00

F [GHz]
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—" Extraction parametres électriques

> On exporte les parameétres S dans un fichier .s4p (Network Data /f
e Pad1_T1

Explorer)
;v . . N . Fadd T1
> On créeé un circuit contenant le modele de la CMC via un Nport | pad2 1| Padd 11
sous Nexxim Circuit Simulator.
> Extraction de l'inductance de mode différentiel : =
XY Plot 1 Ay
100.00 — Curve Info

] [ Mame [ x [ v e

4 m1 0.0100 | 0.5346
- Ldiff = 8.507 pH
E 10.00
2 ]
s ]
:3 _
s
@ 1.00 o
= i

E

010 T T T T T T T T T T T T T T T T T T T T T T T T
0.0 0.10 1.!]0 100

F [GHz]
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—" Extraction parametres électriques

> On exporte les parameétres S dans un fichier .s4p (Network Data

Explorer)
> On créé un circuit contenant le modéle de la CMC via un Nport ot e
sous Nexxim Circuit Simulator. = = %
> Extraction de 'inductance de mode commun : T
XY Plot 1 Circuit1 4
100.00 e Curve Infa
1 [Name [ x | v T
1 m1 | 0.0100| 0.0976
st Lcm = 1.553 pH
'E‘ ]
& ]
E_ 1.00
L
A _
E .
0.10 5_
00-1 T T T T T T T T | T T T T T T T T J] T T T T T T T T
0.01 010 1.00 10.00

F [GHz]
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> Sélectionner tous les objets formant le connecteur.
>
> Modifier les paramétres si nécessaire et 'enreaistrer n’im

B " Create 30 Component

s

Name:  [CMS_ACT458

Owner: 1

Email: 1adminabu:u:.'er@'ﬁ'2ﬂ'ﬂ[l'.laas.fr
Company: |

Version: I1 0

Date: ]12:DI}:45 mai 25, 2020
Motes:

Modéle simplfié common-mode choke TDK ACT45E|

[ Display image in 30 modeler window whenever this component is used.

Image File: I Browse...
Irfo I Model | Boundaries ] Excitations J Mesh Operations ]
Coordinate Systems | Parameters ] Encryption | Image ]

.

Cancel

Création d'un composant 3D

Draw > 3D Component Library > Create 3D Component ou clic droit > Create 3D Component

porte ou.

]

Laboratoire d’analyse et d’architecture des systémes du CNRS
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>

Project Manager

=E

ﬁ 30 Components
[ F Boundaries
-} Excitations
l@ Optimetrics

[ Port Field Dlsplay

x|y 1z, Coordinate

HFESDESIgnl (DrivenTern ~ l -4 Planes
H-¢5 Lists

Browse 30 Component...
Insert Instance

[iefi =
BB Mesh Operation: Defintions...

ﬁ Analysis

Set Do Mesh Assemnbly...

FH] Results

|- T i

Insert 30 Component

Mame 1 Value | Lnits | Evaluated Value Description

Hgnd 0.1 mim 0.1mm
Hloop 05 mm 0.5mm
Rloop 1 mm Imm
Rwire 0.05 mm 0.05mm
Seploop (0.5 mm 0.5mm

@ Browse 3D Component

Regarder dans : |

*

Acces rapide

Bureau
|
Bibliotheques

Ce PC

=

Réseau

PersonalLib

Creation d’'un composant 3D

Créer un nouveau projet et insérer un design HFSS

Projet CMC ] = ck Er
Nom - Modifié le Type
ProjectCMC.aedtresults 25/05/2020 11:54 Dossi
ProjectCMC_2.aedtresults 22/05/2020 13:41 Dossi
ProjectCMC_sans_ferrite.aedtresults 22/05/2020 18:00 Dossi
SimuCircuitCMC.aedb 22/05/2020 18:26 Dossi
SimuCircuitCMC aedtresults 22/05/2020 18:26 Daossi
| | CMS_ACT45B.a3dcomp 25/05/2020 12:02 Fichie
< »
Nom du fichier - |CMS_ACTA58 | Ouvrir |

Types de fichiers ; |Component Files (*.a3dcomp)

Userlib ] Syslib 1

Annuler

Image

Infa

Parameters ||TIEQE] Infa ]

Target Coordinate System: ] Global Li

Model is positioned such that the reference coordinate system in the model is aligned

with spedfied coordinate system in the target desian.

OK | Cancel
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==~ Création d’'un composant 3D

> Le composant est placé a un endroit par défaut (origine du repere)

> Les excitations du composant 3D sont automatiquement incluses dans le modéle HFSS.

> Le composant peut ensuite étre déplacé, tourné, dupliqué a I'aide des commandes Move, Rotate,
Duplicate.

Project Manager
- HFSSDesignl
= 30 Components

..... £ CM5_ACT45B1

(DrivenTermin

-8 CMS_ACT4581_1
[ B8 CMS_ACT4581_2
BB CMS_ACT4581_3
B8 CMS_ACT4581_4

CMS_ACT45B1
Coordinate... Global
Defirition ... mm

Location |

Mame

3D Compo... .C:,-’Llsersfadminabw...

General | Parameters | Command |

Clggp CMS_ACT458
18 CMS_ACT45B1
-7 Selids
I:I Sheets
‘\+ Lines

| =-12, Coordinate Systerns

-4 Planes
-5 Lists

Laboratoire d’analyse et d’architecture des systémes du CNRS

e

0 2.5 & ({mm)




